
 

   Filter 
  ตั ว ก ร อ ง แ ส ง  

Filter คือตัวกรอง ซึ่งหมายถึงโปรแกรมที่ใชในการเปล่ียนรูปแบบภาพให เปนรูปแบบที่ตองการใช
เสมือน Filter ของกลองถายรูป ใน Photoshop มี Filter ใหเลือกใชมากมาย อีกท้ังยังสามารถติดต้ัง Filter 
เพ่ิมเติมไดอีกดวย 

                                                                  
 

      
 

การใชงาน Filter ทุกชนิดสามามรถทําไดโดย
เปดหนาตาง Filter Gallery แลวเลือกใช และ
กําหนดคา การเปดหนาตาง Filter Gallery โดย
คลิกท่ี Menu Filter แลวเลือกใช Filter ใดๆ ก็ได 
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Filter Gallery 

คําสั่ง Filter หลายชนิดจะมีหนาตาง Filter Gallery ท่ีรวม Filter ท่ีสามารถใชรวมกันมากกวาหนึ่งชนิด
ได ใหเลือกใชงานผสมผสานกัน Filter Gallery เปนเคร่ืองมือกําหนดคา มีรายละเอียดดังนี้ 

 

 
 

A :   พ้ืนท่ีแสดงผลที่ไดจาก Filter ท่ีเลือกใชงาน 
B :   สวนควบคุมการขยายหรือยอมุมมอง (Zoom-in, Zoom-Out) พ้ืนท่ีแสดงผล 
C :   แถบหัวขอของกลุม Filter สามารถคลิกเพ่ือเปดหรือปดการแสดงรายการ Filter ได 
D :   รายการ Filter สําหรับเลือกใชงาน 
E :   แถบหัวขอของกลุม Filter สามารถคลิกเพ่ือคล่ีรายการยอยในหัวขอ และคลิกอีกคร้ังเพ่ือเก็บ

รายการยอย 
F :   รายการ Filter ท้ังหมดใหคลิกเลือกใชงาน 
G :   สวนปรับคา Filter ท่ีเลือกใชงานอยู  โดยในสวนนี้จะเปล่ียนไปตาม Filter ท่ีกําลังเลือกใชงานอยู 
H :   แถบแสดง Filter ท้ังหมดที่ใชงานกับภาพ โดยดานหนาของ Filter จะมีไอคอนรูปตา แสดงวา

แสดงการใชงาน Filter นี้อยู แตถาไมมีรูปตาแสดงวาไมไดแสดง Filter นั้นอยู 
I :   ปุมสําหรับคลิกเพ่ิม Filter ใหมเขาไปในรายการ ทําไดโดยคลิกท่ีปุม New Effect Layer จะได 

Filter ใหมเปน Filter เดียวกับท่ีเลือก หลังจากน้ันคลิกเลือก Filter ใหมท่ีตองการ 

A 

B 
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I 
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   Artistic Filter 
  ตั ว ก ร อ ง แ บ บ ศิ ล ป ะ  

Artistic Filter คือกลุม Filter ท่ีใชเปล่ียนภาพในพื้นท่ีทํางานที่เลือกใหกลายเปนภาพวาดแบบศิลปะ 
Artistic Filter ประกอบดวย Filter Grallery ดังนี้ 
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   Blur Filter 
  ตั ว ก ร อ ง แ บ บ ภ า พ พ ร า มั ว  

 

 
 

 
 

 
 

 

Blur Filter คือกลุม Filter ท่ีใชเปล่ียนภาพในพ้ืนที่ทํางานท่ีเลือกให
กลายเปนภาพพรามัว Blur Filter ประกอบดวย Filter Grallery ดังนี้ 

Averrang เปน Filter สําหรับเปล่ียนพ้ืนท่ีทํางานใหเปนสีเดียว โดยสีนี้จะ
เปนสีท่ีไดมาจากคาเฉล่ียของสีท่ีมีอยูท้ังหมดในพื้นที่ทํางาน 

Blur เปน Filter สําหรับเปล่ียนพ้ืนที่ทํางานใหพรามัว 

Blur More เปน Filter สําหรับเปล่ียนพ้ืนท่ีทํางานใหพรามัวมากกวา Blur 
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Box Blur เปน Filter สําหรับเปล่ียนพ้ืนท่ีทํางานให
พรามัวโดยดึงความพรามัวออกไป 4 ทิศทาง 

ปรับระดับความพรามัว

Gaussian Blur เปน Filter สําหรับเปล่ียนพ้ืนท่ีทํางาน
ใหพรามัวทุกจุดสม่ําเสมอ 

ปรับระดับความพรามัว

Lens Blur เปน Filter สําหรบัเปล่ียนพ้ืนที่ทํางานให
พรามัว โดยจําลองลักษณะการทํางานของเลนส
ถายภาพ 

สวนกําหนดคา Lens Blur

Motion Blur เปน Filter สําหรับเปล่ียนพ้ืนท่ีทํางานให
พรามัวในลักษณะเหมือนภาพมีการเคล่ือนท่ีไปใน
ทิศทางใดทิศทางหน่ึง 

ปรับทิศทางการเคล่ือนท่ี
ปรับระดับความพรามัว

ใบความรู้ท่ี 4 เรื่อง Filter ชั้นมัธยมศึกษาปีที่5

http://rainrainroom.exteen.com 5

nonny
Text Box
    http://natanon.com



  
 

 
 

  
 
 
 
 
 
 
 
 
Smart Blur เปน Filter สําหรับเปล่ียนพ้ืนที่ทํางานใหพรามัว เฉพาะสีท่ีมีโทนสีใกลเคียงกันเทานั้น 
 

     
             Normal                            Edge Only                     Overlay Edge 

Radial Blur เปน Filter สําหรับเปล่ียนพ้ืนท่ีทํางานให
พรามัวแบบวงลอหมุน (Spin) และแบบเคล่ือนท่ีเขาหา
อยางรวดเร็ว (Zoom) 

ปริมาณความพรามัว
แนวความพรามัว

แนวความพรามัว คลิกลากปรับตําแหนง 
จุดโฟกัส 

ปรับระดับความพรา

เลือก Shap ท่ีตองการ
นําเอาไปทําความพรา
มัว 

Shape Blur เปน Filter สําหรับ
เปล่ียนพ้ืนที่ทํางานใหพรามัวโดย
ใช Shape เปนตัวกําหนดรูปราง
ความพรามัว 
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กําหนดระดับความพรามัว

กําหนดความกวางของโทนสี
กําหนดระดับคุณภาพ

กําหนดโหมด

ตัวอยางผลที่เกิดกับภาพ

Surface Blur เปน Filter สําหรับเปล่ียนพ้ืนที่ทํางาน
ใหพรามัวเฉพาะสีท่ีใกลเคียงกันเขาหากัน 
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   Brush Stork Filter 
  ตั ว ก ร อ ง แ บ บ ฝ แ ป ร ง ร ะ บ า ย สี  

Brush Stork Filter คือกลุม Filter ท่ีใชเปล่ียนภาพในพ้ืนที่ทํางานท่ีเลือกใหเปนภาพท่ีระบายดวยแปรง
ระบายสีแบบตางๆ  Brush Stork Filter ประกอบดวย Filter Grallory ดังนี้ 
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   Distort Filter 
  ตั ว ก ร อ ง แ บ บ ทํา ภ า พ ใ ห บิ ด เ บ้ี ย ว  

Distort Filter คือกลุม Filter ท่ีใชเปล่ียนภาพในพ้ืนท่ีทํางานที่เลือก ใหเปนภาพท่ีบิดเบ้ียว  Distort 
Filter ประกอบดวย Filter Grallory ดังนี้ 

       
 

 
 
 
 

 
 
 
 

Polar Coordinates เปน Filter สําหรับมวนภาพเปนวงกลม 

       
 
 

Pinch เปน Filter สําหรับใชดึงภาพใหดูนูนขึ้น 
หรือใหดูยุบลงไป 

นูนขึ้น

ยุบลง

 Rectangular to Polar           Polar to Rectangular 
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Ripple เปน Filter สําหรับทําภาพใหเปนคล่ืน 
 

 
 
 
 
 

Shear เปน Filter สําหรับทําภาพบิดงอในแนวตั้ง 
 

 
 
 
 
 
 

Spherize เปน Filter สําหรับทําภาพโปงและยุบในลักษณะลูกบอล และทอแนวตั้ง แนวนอน 
 

                         
 

     

กําหนดความแรงลูกคล่ืน 
กําหนดขนาดคล่ืน

ใชเมาสคลิกลากปรับแนวกราฟซึ่งจะ
มีผลกับภาพดังตัวอยางดานลาง 

Wrap Around ทําซ้ําภาพสวนที่ขาดไป 
Repeat Edge Pixels ไมทําซ้ําภาพ
สวนท่ีขาดไป
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Twirl เปน Filter สําหรับทําภาพโปงและยุบในลักษณะลูกบอล และทอแนวตั้ง แนวนอน 
 

   
 
 
Wave เปน Filter สําหรับทําภาพเปนคล่ืนบนผิวน้ํา 
 

     
               Sine ซายน                          Triangle  สามเหลี่ยม                       Square ส่ีเหลี่ยม 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Wave เปน Filter สําหรับทําภาพเปนคล่ืนบนผิวน้ํา 
 

 
 
 
 

กําหนดจํานวนมุมการหมุนวน 
กําหนดตัวอยางลักษณะหมุนวน 

จํานวนลูกคล่ืน 

ความยาวคล่ืน 

กําหนดตําแหนงของคล่ืน 

ขนาดของลูกคล่ืน 

จํานวนวงคล่ืน 
ความสูงคล่ืน 
เลือกรูปแบบลูกคล่ืน 

แสดงตัวอยางเปน Pattern 
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Lens Correction เปน Distort สําหรับทําหนาท่ีเหมือนเลนสเวาและเลนสนูน โยก บิดภาพ Filter นี้มี
รายละเอียดมากมายใหกําหนดคา 

 

 
 
A :   เครื่องมือสําหรับคลิกแลวสามารถลากในภาพ Preview เพ่ือทําภาพนูนหรือเวา 
B :   เครื่องมือสําหรับคลิกแลวสามารถลากในภาพ Preview เพ่ือหมุนภาพ 
C :   เครื่องมือสําหรับคลิกแลวสามารถลากในภาพ Preview เพ่ือยายตําแหนงตาราง Grid 
D :   เครื่องมือสําหรับคลิกแลวสามารถลากในภาพ Preview เพ่ือยายตําแหนงภาพแสดงผล 
E :   เครื่องมือสําหรับคลิกแลวสามารถลากในภาพ Preview เพ่ือขยายภาพแสดงผล ถากดคีย Alt คาง

เปนการยอภาพ 
F :   กาํหนดคาการยอขยายภาพในลักษณะนูนหรือเวา 
G :   แกอาการที่ปรากฏแถบสีท่ีไมตองการสีระหวางแดงและบานเย็น และระหวางสีน้ําเงินกับ 
H :   ทําใหภาพถายท่ีมีความสวางคอยๆ ลดจางลงบริเวณขอบภาพ โดยมีแถบปรับคาความมืดสวาง 

และแสงระดับกลาง 
I :   การเปล่ียนแปลงรูปรางของภาพ ใหมีมุมมองเหมือนกับท่ีตามองเห็นโดยมีแถบปรับคาเปนมุมมอง

แนวตั้ง และมุมมองแนวนอน 
J :   กําหนดมุมการหมุนภาพ 
K :   กําหนดลักษณะพ้ืนที่ขอบสวนท่ีหายไปจากพ้ืนที่ทํางานใหเปน 3 แบบคือ Edge Extension 

กระจายสีจากขอบภาพจนเต็มพ้ืนท่ีทํางาน Transparency ใชความโปรงใส Background Color 
ใชสีพ้ืนหลัง 

L :   กําหนดคาการยอขยายภาพ 
M :   ยอ ขยาย มุมมองภาพใน Preview 
N :   กําหนดใหแสดง ไมแสดง Gide, กําหนดความกวางระหวางเสน Gide, กําหนดสีของ Gide 

A 

B 

C 

D 

E F 
 
G
  
  

H 
 
 
 
I 
 
J 
 
K 
 
L 

M 

N
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   Noise Filter 
  ตั ว ก ร อ ง แ บ บ จุ ด สี ร บ ก ว น  

Noise Filter คือกลุม Filter ท่ีใชสรางสีรบกวนในพ้ืนที่ทํางานท่ีเลือก สามารถเปดหนาตาง Noise Filter 
ขึ้นมาทํางานไดโดยคลิกท่ี Menu Filter > Noise  แลวเลือกรายการท่ีตองการดังนี้ 

 
 

 
 

 

 

 

   

Add Noise เปน Filter สําหรับสรางจุดสีรบกวนลง
ในภาพ 

กําหนดปริมาณจุดสีรบกวน 
Uniform ตัวเลือกใหเติมสีรบกวนที่เหมือนกันทั้งภาพ 
Gaussian ตัวเลือกใหเติมสีรบกวนจาการเฉลี่ยสีเดิม 
Monochromatic กําหนดใหสีรบกวนเปนสีเดียว 

Despeckle เปน Filter สําหรับลบจุดสีรบกวนเล็กๆ
ออกจากภาพ 
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Reduce เปน Filter ท่ีใชแกไข ลด-เพ่ิม จุดสีรบกวน 

 

Dust & Scratches เปน Filter ท่ีทําใหเหมือนสีน้ําท่ี
ซึมเขาหากัน

รัศมีท่ีสีกระจายเขาหากัน 
ระดับการกระจายโทนส ี

Median เปน Filter ท่ีใชเฉล่ียสีแตละ Pixel ออกไป
รอบๆ

ปรับความหนาแนนของจุดสีรบกวน 
รอยละการรักษารายละเอียดของภาพ 
รอยละการลดจํานวนสีรบกวน 
รอยละความคมชัดของภาพ 
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   Pixelate Filter 
  ตั ว ก ร อ ง แ บ บ แ ก ไ ข จุ ด P i x e l ข อ ง ภ า พ  

Pixelate Filter คือกลุม Filter ท่ีใชแกไขลักษณะจุด Pixel ในพ้ืนที่ทํางานท่ีเลือก สามารถเปดหนาตาง 
Pixelate Filter ขึ้นมาทํางานไดโดยคลิกท่ี Menu Filter > Pixelate แลวเลือกรายการท่ีตองการดังนี้ 

 
 

   
 

 

 
 

 

Color Halftone เปน Filter สรางภาพแยกสี
สําหรับทําเพลทสิ่งพิมพ เหมาะสําหรับโหมด 
CMYK ท่ีมีความละเอียด 300 dpi 

กําหนดขนาดใหญสุดของ Pixel

กําหนดน้ําหนักสีของแตละ Channel 

Crystallize เปน Filter สําหรับแกไขให ภาพ
เปนผลึกคริสตัล

ขนาดของเซลลคริสตัล

ใบความรู้ท่ี 4 เรื่อง Filter ชั้นมัธยมศึกษาปีที่5
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Mezzotint เปน Filter สําหรับทําใหภาพมีลักษณะเปนภาพพิมพ ท่ีใชเทคนิคการแกะแมพิมพแบบตางๆ 

          
 Fine Dots Medium Dots Grainy Dots Coarse dots 

           
 Short Lines Medium Lines Long Lines 

       
 Short Strokes Medium Strokes Long Strokes 

Facet เปน Filter สําหรับเกล่ียสีของ Pixel ใกลเคียงกันเขาหากัน ทําใหสี
ภาพดูเรียบเนียนดูคลายภาพเขียน 

Fragment เปน Filter สําหรับทําใหภาพแตกออกเปนหลายภาพซอนกัน 
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   Render Filter 
  ตั ว ก ร อ ง แ บ บ ส ร า ง ภ า พ ข้ึ น ม า ใ ห ม  

Render Filter คือกลุม Filter ท่ีใชสรางภาพขึ้นมาใหมในพ้ืนที่ทํางานท่ีเลือก สามารถเปดหนาตาง 
Render Filter ขึ้นมาทํางานไดโดยคลิกท่ี Menu Filter > Render แลวเลือกรายการท่ีตองการดังนี้ 

 
 

 

Mosaic เปน Filter สําหรับทําใหภาพมีลักษณะเปน
ลวดลายกระเบ้ืองโมเสค 

ขนาดดานของกระเบื้องโมเสค

Pointillize เปน Filter สําหรับทําใหภาพมีลักษณะ
ขยายตัวทําใหกลายเปนแบบจุดส ี

ขนาดของจุดสี

Clouds  เปน Filter สําหรับสรางหมอกควันขึ้นมาในพ้ืนที่ทํางาน โดยสีของ
หมอกควันจะเกิดจากสีของ Color Box ในสวนของ Backgound และ 
Foregound Color ท่ีกําลังเลือกใชงาน 

ใบความรู้ท่ี 4 เรื่อง Filter ชั้นมัธยมศึกษาปีที่5
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Difference Clouds  เปน Filter สําหรับสรางหมอกควันขึ้นมาในพื้นที่ทํางาน
โดยสีของหมอกควันจะเกิดจากสีของ Color Box ในสวนของ Backgound และ 
Foregound Color ท่ีกําลังเลือกใชงานผสมกับสีของภาพ และมีการ Invert สี
ภาพอีกดวย 

Fibers  เปน Filter สําหรับสรางเสนใยขึ้นมาในพื้นที่ทํางานโดยสีของเสนใยจะ
เกิดจากสีของ Color Box ในสวนของ Backgound และ Foregound Color ท่ี
กําลังเลือกใชงาน 

Lens Flare  เปน Filter สําหรับสรางจุดยอนแสงขึ้นมาใน
พ้ืนท่ีทํางาน โดยสามารถกําหนดตําแหนงโฟกัสของแสง 
ความสวาง และชนิดของเลนส 

กําหนดรอยละความสวาง 
เลือกชนิดของเลนส 

คลิกและลากเพ่ือจัดตําแหนงโฟกัสของแสง 

ใบความรู้ท่ี 4 เรื่อง Filter ชั้นมัธยมศึกษาปีที่5
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Preset ชุดจัดแสงสําเร็จรูป 

ปุมบันทึกชุดแสงที่สรางขึ้นเปน 
Preset 

ชนิดของหลอดไฟ 
ปด-เปด หลอดไฟ

กําหนดความสวาง
กําหนดโฟกัส

สีของแสง 
กําหนดรายละเอียด 

ความแวววาว 
ผิวอโลหะ และโลหะ 
ปริมาณความสวาง 
สภาพแสงโดยรอบ 

เลือก Channel สีของ
พ้ืนผิวท่ีกระทบแสง 

คลิกลากเพ่ิมหลอดไฟเขา
ไปในพ้ืนที่ทํางาน 

Lighting Effect  เปน Filter สําหรับสรางแหลงสองแสง ขึ้นมาในพื้นที่ทํางาน โดย
สามารถกําหนดตําแหนงโฟกัสของแสง ความสวาง และชนิดของเลนส 
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   Sharpen Filter 
  ตั ว ก ร อ ง เ ก่ี ย ว กั บ ค ว า ม ค ม ชั ด  

Sharpen Filter คือกลุม Filter ท่ีใชทําใหภาพในพ้ืนที่ทํางานคมชัดขึ้น สามารถเปดหนาตาง Sharpen 
Filter ขึ้นมาทํางานไดโดยคลิกท่ี Menu Filter > Sharpen แลวเลือกรายการที่ตองการดังนี้ 

 

 
 
 

 
 

 
 

 

Sharpen  เปน Filter สําหรับเพ่ิมความคมชัด 

Sharpen Edge เปน Filter สําหรับชวยตัดเสนแบงระหวางโทนสีท่ีแตกตาง
กันในภาพใหดูชัดเจนขึ้น

Sharpen More เปน Filter สําหรับชวยเพ่ิมความคมชัดในทุกๆ พ้ืนท่ีของ
ภาพในพ้ืนท่ีทํางาน

ใบความรู้ท่ี 4 เรื่อง Filter ชั้นมัธยมศึกษาปีที่5
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Smart Sharpen เปน Filter สําหรับเพ่ิมความคมชัดใหกับภาพ โดยมี
หนาตางสําหรับปรับแตงรายละเอียดการทํางานได

กําหนดปริมาณความคมชัด 
กําหนดรัศมีของเสนตัดระหวางโทนสีในภาพ 
กําหนดลักษณะการลบความพรามัวออกจากภาพ 
กําหนดทิศทางการลบความพรามัวออกจากภาพ 

Unsharp Mask เปน Filter สําหรับเพ่ิมความคมชัดใหกับภาพ มีหนาตาง
สําหรับปรับแตงรายละเอียดการทํางานได

กําหนดปริมาณความคมชัด 
กําหนดรัศมีของเสนตัดระหวางโทนสีในภาพ 
กําหนดลักษณะการกระจายโทนสี 
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   Sketch Filter 
  ตั ว ก ร อ ง สํา ห รั บ ส ร า ง ภ า พ ร า ง  

Sketch Filter คือกลุม Filter ท่ีใชเปล่ียนภาพในพื้นท่ีทํางานที่เลือกใหกลายเปนภาพวาดแบบศิลปะ 
Sketch Filter ประกอบดวย Filter Grallery ดังนี้ 
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   Stylize Filter 
  ตั ว ก ร อ ง สํา ห รั บ แ ก ไ ข ส ไ ต ล ภ า พ  

Sketch Filter คือกลุม Filter ท่ีใชเปล่ียนภาพในพื้นท่ีทํางานที่เลือกใหกลายเปนภาพวาดแบบศิลปะ 
Sketch Filter ประกอบดวย Filter Grallery ดังนี้ 

 

  
 
 
 
 

 
 
 
 
 
 
 

 
 

Emboss  เปน Filter สําหรับแกไขภาพใหเปนภาพ
แกะสลักนูนต่ํา 

มุมของแสงเงา 
กําหนดคาความนูนของรอยสลัก 
กําหนดปริมาณรายละเอียดของรอยสลัก 

Extrude  เปน Filter สําหรับทําใหภาพแตกเปนแทงๆ 
พุงออกมา 

กําหนดรูปแบบของแทง Blocks (แทง) Pyramids (พีระมิด)

ขนาดความกวางของ Block และ Pyramids 
Random สุมตัวอยาง  Level-based ระดับเทากันจากฐาน 
ตัวเลือกใหหนาแตละ Blocks กลายเปนสีเดียว 

ตัวเลือกให Blocks ปรากฏใหเห็นทั้งหมด
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Fine Edge เปน Filter สําหรับทําใหภาพ กลายเปนภาพลายเสน โดยใชแนว
ความแตกตางของโทนสีสรางเปนเสนขึ้นมา

Glowing Edge เปน Filter สําหรับทําใหภาพ กลายเปนภาพลายเสน โดย
กลับสีเปนตรงขามกับ Fine Edge และขยายแนวเสนใหใหญขึ้นดวย 

Glowing Edge เปน Filter สําหรับทําใหไหมเกรียมเพราะแสง 

Tiles เปน Filter สําหรับทําใหภาพกลายเปนลายกระเบ้ือง 

จํานวนกระเบื้องในแตละแถว 
ขนาดกวางท่ีสุดของรอยตอกระเบ้ือง

 
เติมสีลงที่รอยตอของกระเบ้ือง
สีพื้นหลัง    ภาพตรงขามกับภาพเดิม    
สีพื้นหนา    ภาพเดิม 

Trace Contour เปน Filter สําหรับเปล่ียนภาพ
เปนภาพรางเคาโครงภาพ 
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   Texture Filter 
  ตั ว ก ร อ ง ส ร า ง พ้ื น ผิ ว  

 

 
 

 
 
 

Wind เปน Filter สําหรับใสเสนกระแสลมพัดลง 
ในภาพ 

Wind กระแสลมพัด 
Blast  ระเบิด 
Stagger ทําใหโซเซ

Wind กระแสลมพัด 
Blast  ระเบิด 

Texture Filter คือกลุม Filter ท่ีใชทําใหภาพในพื้นที่มีพ้ืนผิว สามารถ
เปดหนาตาง Texture Filter ขึ้นมาทํางานไดโดยคลิกท่ี Menu Filter > 
Texture แลวเลือกรายการท่ีตองการดังนี้ 

Craquelure คือกลุม Filter ท่ีใชทําใหภาพในพ้ืนท่ีมีพ้ืนผิว 
แบบรอยแตกของพ้ืนดินแหง 

 
Crack Spacing คาระหวางของรอยแตก 
Crack Depth คาความลึกของรอยแตก 
Crack Brightness คาความสวางของรอยแตก 

ใบความรู้ท่ี 4 เรื่อง Filter ชั้นมัธยมศึกษาปีที่5
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Grain คือกลุม Filter ท่ีใชทําใหภาพพรามัวโดยมีจุดหยาบๆ
ในภาพ 

 
Indensity คาสวางของภาพ 
Contrart คาความมืดทึบของภาพ 
Grain Type ตัวเลือกสําหรับกําหนดรูปแบบจุดในภาพ 

Mosaic Tiles คือกลุม Filter ท่ีใชทําใหภาพมีลักษณะ
กระเบ้ืองโมเสค 

 
Tile Size กําหนดขนาดของแผนกระเบื้อง 
Grout Width คาระยะหางของรองระหวางกระเบ้ือง 
Lighten Grout ความสวาง 

Stained Glass คือกลุม Filter ท่ีใชทําใหภาพเหมือนกระจก
สีประดับอาคาร 

Textureizer คอืกลุม Filter ท่ีใชทําใหภาพมีพ้ืนผิวเปนวัตถุ
ชนิดตางๆ 

 
Texture เลือกรูปแบบของพื้นผิว 
Scalling คาขนาดลวดลายพื้นผิว 
Relief คาความเขมของพ้ืนผิว 
Light กําหนดทิศทางของแสงท่ีเขามานกระทบพ้ืนผิว 
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   Other Filter 
  ตั ว ก ร อ ง อ่ื น ๆ  

 

 
 
Custom เปน Filter แบบท่ีใหสามารถกําหนดคาตัวแปรแสงสวาง จากตําแหนงทิศทางตางๆ ของ Pixel ใน
ภาพโดยตัวเลขที่กําหนดลงไปจะถูกประมวลผลเปนผลของ Filter นี้ 
 

 
 
 
 

A :   กลุมชองกําหนดคาตัวแปร(-99 - 99)ทีใชคํานวณเปนผลของ Filter  
B :   กําหนดขนาด 
C :   คาชดเชยแสง 

Other Filter คือกลุม Filter อื่นๆ สามารถเปดหนาตาง Other Filter 
ขึ้นมาทํางานไดโดยคลิกท่ี Menu Filter > Other แลวเลือกรายการท่ี
ตองการดังนี้

A

B C 
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High Pass เปน Filter สําหรับแสดงรายละเอียด
ความเขมท่ีเสนตัดระหวางโทนสีในภาพ 

 

 

 

กําหนดรัศมีการทํา High Pass 

Maximum เปน Filter สาํหรับเพ่ิมขนาดใหกับ 
Pixel ท่ีมีโทนสวาง 

 

 

 

กําหนดรัศมีของจุดสวาง 

Minimum เปน Filter สําหรับเพ่ิมขนาดใหกับ Pixel 
ท่ีมีโทนมืด 

 

 

 

กําหนดรัศมีของจุดมืด 

Offset เปน Filter สําหรับgเล่ือนภาพไปตามแนวตั้งและแนวนอน 

กําหนดคาการเลื่อนภาพในแนวนอน 

กําหนดคาการเลื่อนภาพในแนวตั้ง 

พ้ืนท่ีสวนเกินของภาพ 
Set to Background ใชสี Background 
Repeat Edge Pixel ทําซํ้าสีที่บริเวณขอบภาพ 
Wrap Around ทําซํ้าจากตัวภาพ 
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   Layer Style Effect 
  เ พ่ิ ม เ ท ค นิ ค พิ เ ศ ษ ใ ห กั บ  L a y e r  

 

 
 

 
 

A :   รายการของ Layer Style ท่ีมีใหใชงาน คลิกเลือกทํางานอยูกับ Layer Style แบบใดรายการนั้นจะ
มีแถบเนนสี 

B :   ตัวเลือกเพ่ือระบุวาจะให Layer Style แบบใดมีผลกับภาพใน Layer บาง ตัวเลือกท่ีมีเครื่องหมาย
ถูก แสดงวามีผลกับ Layer ท่ีกําลังทํางานอยู 

C :   สวนสําหรับกําหนดคาตางๆ ของ Layer Style สวนนี้จะเปล่ียนรายละเอียดไปตาม Layer Style ท่ี
ถูกเลือกใชงาน (Layer ท่ีมีแถบเนนสี) 

D :   สวนแสดงผลการปรับแตงคา Layer Style ท่ีได 
 

 

Layer Style เปนคําสั่งท่ีชวยเพ่ิมเทคนิคพิเศษลงใน Layer ท่ี
เลือกทํางาน Layer Style ท่ีมีใหเราเลือกใชงานมีอยูหลายชนิด 
สามารถใช Layer Style ไดโดยคลิกท่ี Menu Layer > Layer Style 
> เลือก Style Effect ท่ีตองการ เมื่อเลือก Style Effect ใดๆ จะมี
หนาตาง Layer Style ใหกําหนดคา 

A 

B 

C

D
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Blending Option 

Layer ท่ีมีใชงานในโปรแกรม Photoshop มีหลายรูปแบบ แตละแบบมีคุณสมบัติและการทํางานท่ี
แตกตางกันไปดังนี้ 

 
 

A :   หัวขอ Blending Options 
B :   ตัวเลือกโหมดผสมสี ของ Layer ท่ีกําลังเลือกทํางาน 
C :   กําหนดรอยละความโปรงใสของ Layer ท่ีกําลังทํางาน 
D :   กําหนดรอยละความโปรงใสของสีใน Layer ท่ีกําลังทํางาน 
E :   ตัวเลือกเพ่ือกําหนดใหแสดงแมสีใน Channel ใดบาง 
F :   ตัวเลือกกําหนดลักษณะการตัดสีออก เมื่อมีการผสม Layer บนและลางเขากันมีใหเลือก 3 ตัวเลือก

คือ 
None :  ไมตัดสีของ Layer ลางออกไปดวย 
Shallow : ตัดสีของ Layer ลางออกในระดับตื้น 
Deep :  ตัดสีของ Layer ลางออกในระดับลึก 

G :   ตัวเลือกเสริมการทํางานของ Layer Style ใน Layer ท่ีกําลังทํางาน 
Blend Interior Effect as Group กําหนดให Layer Style มีผลกับทุก Layer ใน Group เดียวกัน 
มีผลเฉพาะ Inner Grow, Satin, Color Overlay, Gradient Overlay 
Blend Clipping Effect as Group กําหนดให Layer Style มีผลกับ Clipping Mask Layer ดวย 
Transparency Shapes Layer กําหนดใหภาพทุก Layer ท่ีอยูดานลางถูกเจาะเปนภาพโปรงใส
ท้ังหมด 
Layer Mask Hide Effect กาํหนดให Layer Mask สามารถเปดซอนผลของ Layer Style ได 
Vector Mask Hide Effect กําหนดให Vector Mask สามารถเปดซอนผลของ Layer Style ได 

H :   ตัวเลือกสําหรับเลือกโทนสีท่ีตองการทํา Blend Layer กับ Layer ลางลงไป 
I :     แถบเล่ือนสําหรับการปรับแตงการทํา Blend Layer 

แถบบน สําหรบักําหนดการ Blend ของ Layer ท่ีกําลังเลือกทํางาน 
แถบลาง สําหรบักําหนดการ Blend ของ Layer ลางท่ีขึ้นมา Blend กับ Layer ท่ีกําลังเลือกทํางาน 

A 
B
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D
E
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I
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Drop Shadow 

Drop Shadow ใชสรางเงาท่ีตกกระทบบนภาพแลวเกิดเปนเงาตกกระทบพ้ืนดานหลังภาพ การ
กําหนดคา Drod Shadow มีรายละเอียดดังนี้ 

 

 
 

A :   หัวขอ Drop Shadow 
B :   ตัวเลือกโหมดผสมสี ของ Layer ท่ีกําลังเลือกทํางานในสวนท่ีเปนเงากับ Layer ท่ีอยูดานลาง 
C :   สวนท่ีใชกําหนดสีของเงา 
D :   การกําหนดคาความโปรงใสของเงา 
E :   คลิกลากใหทิศทางของเงา หรือกําหนดตัวเลของศาของเงา และ Use Globel Light สําหรับเลือก

ใหทิศทางของเงามีผลกับทุกๆ Layer ในทิศทางเดียวกัน 
F :   กําหนดระยะหางของเงากับภาพเปน Pixel 
G :   กําหนดรอยละความคมชัดของเงา 
H :   กําหนดขนาดของเงาเปน Pixel 
I :     คลิกเปดหนาตาง รูปแบบโครงสรางของเงา และตัวเลือก Anti-aliased ปองกันรอยหยักตรงสวน

โคง 
 

 
 

 
              Linear                               Cone                            Cone-invert                       Cove-deep                      Cove-Shallow                        Gussian 

 
             Haft-Round                            Ring                           Ring-Double                         Rolling                         Rounded-Steps                     Sawtooth 

A 
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G

H
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Cone Cone-invert Cove-deep Cove-Shallow Gussian 

Haft-Round Ring Ring-Double Rolling Rounded-Steps Sawtooth 
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1. คลิกท่ี Contour เพ่ือเปดหนาตาง Contour Editor 
2. ตั้งชื่อ Preset เพ่ิอเปนชื่อท่ีจะบันทึกไว 
3. ลากเพ่ือแกไขเสนกราฟตามตองการ 
4. กําหนดรอยละคานําเขา 
5. กําหนดรอยละคาการสงออก 
6. ตัวเลือกกําหนดใหเสนกราฟมีลักษณะหักมุมบริเวณ Contorl Point 
7. การกําหนดชื่อให Contour ใหมท่ีสรางขึ้น 
8. บันทึกและเรียกใช Contour ท่ีบันทึกไวเปน Preset 
9. ปุม OK ตกลงการกําหนดคา และปุม Cancel ยกเลิกการกําหนดคา 

 
J :   กําหนดรอยละใหเงาเกิดจุดสีรบกวน (Noise) 

        
                                Noise = 0                                      Noise = 100 

Inner Shadow 

Inner Shadow ใชสรางเงาท่ีขอบภายในของภาพ การกําหนดคา Inner Shadow มีรายละเอียด
เชนเดียวกับ Drop Shadow เพียงแตเงาท่ีเกิดขึ้นที่ขอบภายในภาพเทาน้ัน 

 

1 
2

3

4 
5 6

7

8

9

ใบความรู้ท่ี 4 เรื่อง Filter ชั้นมัธยมศึกษาปีที่5

http://rainrainroom.exteen.com 32

nonny
Text Box
    http://natanon.com



 

Outer Glow 

Outer Glow ใชสรางละอองเรืองแสงรอบๆ Layer การกําหนดคา Outer Glow มีรายละเอียดดังนี้ 

 
 

A :   หัวขอ Outer Glow 
B :   ตัวเลือกโหมดผสมสี ของ Layer ท่ีกําลังเลือกทํางานในสวนท่ีเปนละอองเรืองแสงกับ Layer ท่ีอยู

ดานลาง 
C :   การกําหนดรอยละคาความโปรงใสของละอองเรืองแสง 
D :   กําหนดรอยละใหละอองเรืองแสงเกิดจุดสีรบกวน (Noise) 
E :   กําหนดสีของละอองเรืองแสง และรูปแบบการไลสีของละอองเรืองแสง 
F :   กําหนดเทคนิคการทําละอองเรืองแสง เปนแบบ Softer คือนุมนวล และแบบ Precise คือแบบ

พิถีพิถัน 
G :   กําหนดรอยละของการกระจายละอองเรืองแสง 
H :   กําหนดขนาด Pixel ของการกระจายละอองเรืองแสง 
I :     คลิกเปดหนาตาง รูปแบบโครงสรางของละอองเรืองแสง และตัวเลือก Anti-aliased ปองกันรอย

หยักตรงสวนโคง เชนเดียวกับ Drop Shadow 
J :   รอยละความแตกตางของสวนท่ีเขมท่ีสุด และจางที่สุด 
K :   รอยละความไมสม่ําเสมอของละอองเรืองแสง 

 
              Linear                               Cone                            Cone-invert                       Cove-deep                      Cove-Shallow                        Gussian 

 
             Haft-Round                            Ring                           Ring-Double                         Rolling                         Rounded-Steps                     Sawtooth 

Inner Glow 

Inner Glow ใชสรางละอองเรืองแสงท่ีขอบภายในของภาพ การกําหนดคา Inner Glow มีรายละเอียด
เชนเดียวกับ Outer Glow เพียงแตละอองเรืองแสงท่ีเกิดขึ้นที่ขอบภายในภาพเทานั้น 
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Bevel and Emboss 

Bevel and Emboss ใชสรางความเอียงของขอบภาพและทําใหภาพเปนลายนูน การกําหนดคา Bevel 
and Emboss มีรายละเอียดดังนี้  

 
 

A :   หัวขอ Bevel and Emboss 
B :   ตัวเลือกสําหรับเลือกรูปแบบการทํา Bevel and Emboss 

      
           Outer Bevel                     Inner Bevel                        Emboss                     Pillow Emboss 

C :   กําหนดเทคนิคการทํา Bevel and Emboss 

     
              Smooth                        Chisel Hard                     Chisel Soft 

D :   กําหนดรอยละความลึกของความเอียง 
    
            Depth = 1%                  Depth = 100% 

E :   กําหนดทิศทางแสงเงา UP และ Down 

        
F :   กําหนดขนาด Pixel ของขนาดชวงลาดเอียง 

    
            Size = 2 Px                  Size = 9 Px 

G :   กําหนดขนาด Pixel ของความนุมนวล 

    
H :   กําหนดมุมตกกระทบของแสง โดยแบงเปนสองคาแสงบนแผนภาพวงกลม 

  Angle คือ มุมมีคาตั้งแต 180 ถึง 0 ถึง -180 
  Altitude คือ ระยะระหวางจุดสูนยกลางถึงเสนรอบวง 0 ถึง 90 

I :   คลิกเปดหนาตาง รูปแบบโครงสรางของความเอียงของขอบภาพและทําใหภาพเปนลายนูน และ
ตัวเลือก Anti-aliased ปองกันรอยหยักตรงสวนโคง เชนเดียวกับ Drop Shadow 

J :   กําหนดสีของแสงมุมสูง และโหมดการผสมสีของแสงมุมสูง 
K :   การกําหนดรอยละคาความโปรงใสของแสงมุมสูง 
L :   กําหนดสีของเงา และโหมดการผสมสีของเงา 
M :   การกําหนดรอยละคาความโปรงใสของเงา 
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Layer Style แบบ Bevel and Emboss ยังมีตัวเลือกยอยอีก 2 หัวขอคือ Contour และ Texture โดยมี
สวนประกอบตางๆ ดังตอไปนี้ 

Contour 

 
A :   คลิกเปดหนาตาง รูปแบบโครงสรางของ Bevel and Emboss เลือกรูปแบบ Contour ท่ีตองการ

และตัวเลือก Anti-aliased ปองกันรอยหยักตรงสวนโคง 
B :   Rang รอยละความแตกตางของสวนท่ีเขมท่ีสุด และจางที่สุด 

          
                      Ring                               Cove-Shallow                                  Cone 

Texture 

 
A :   คลิกเปดหนาตางรูปแบบ Pattern เลือกรูปแบบ Pattern ท่ีตองการ 
B :   กําหนดรอยละขนาดของลวดลาย 
C :   กําหนดรอยละความลึกของลวดลาย 
D :   กําหนดใหลวดลายเปนสีตรงขาม 

   
           Scale 40% Depth 0%             Scale 40% Depth +1000%          Scale 80% Depth +1000% 

A

B

A

B
C

D
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Satin 

Satin ใชสรางเทคนิคท่ีทําใหภาพมีแสงเงาเหล่ือมคลายผาซาตินหรือผาตวน  โดยการจําลองตัวภาพ
มาซอนทําเปนลายของภาพ การกําหนดคา Satin มีรายละเอียดดังนี้  
 

 
 

A :   หัวขอ Satin 
B :   ตัวเลือกโหมดผสมสี ของ Layer ท่ีกําลังเลือกทํางานในสวนท่ีลายผากับภาพตนฉบับ 
C :   กําหนดสีของลายเหล่ือมผาซาติน 

   
        Color = Red             Color = Yellow             Color = magenta              

D :   กําหนดรอยละความโปรงแสงทึบแสงของลายเหลื่อมผาซาติน 

   
        Opacity = 40              Opacity = 70               Opacity = 100 

E :   กําหนดมุมตกกระทบของแสง โดยแบงเปนสองคาแสง บนแผนภาพวงกลม 
             Angle คือ มุมมีคาตัง้แต 180 ถึง 0 ถึง -180 

        
        Angle = 45                 Angle = 90                 Angle = 180 

F :   กําหนดขนาด Pixel ของระยะหางระหวางลายเหล่ือมของผาซาติน 

   
      Distance = 10 Px           Distance = 20 Px          Distance = 30 Px 

G :   กําหนดขนาด Pixel ของลายเหล่ือมของผาซาติน 

   
        Size = 0 Px                 Size = 5 Px                Size = 10 Px 

H :   คลิกเปดหนาตาง รูปแบบโครงสรางของลายเหล่ือมของผาซาติน  
Anti-aliased ปองกันรอยหยักท่ีสวนโคง 
Invert กลับสีลายเหล่ือมของผาซาตินเปนทิศทางตรงขาม 

  
                                    ปกติ                        Invert

A 

B C

D
E

F
G

H
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Color Overlay 

Color Overlay ใชสําหรับนําเอาเฉดสีท่ีเราเลือกไปแทนที่ภาพใน Layer การกําหนดคา Color Overlay 
มีรายละเอียดดังนี้  

 
 

A :   หัวขอ Color Overlay 
B :   ตัวเลือกโหมดผสมสี ของ Layer ท่ีกําลังเลือกทํางานในสวนท่ีลายผากับภาพตนฉบับ 
C :   กําหนดสีของ Color Overlay 
D :   กําหนดรอยละความโปรงแสงทึบแสงของ Color Overlay 

     
            Opacity = 0 %                          Opacity = 50 %                         Opacity = 100 %           

A 

B C

D
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Gradient Overlay 

Color Overlay ใชสําหรับนําเอาการไลสีท่ีเราเลือกไปแทนที่ภาพใน Layer การกําหนดคา Color 
Overlay มีรายละเอียดดังนี้  

 

 
 

A :   หัวขอ Gradient Overlay 
B :   ตัวเลือกโหมดผสมสี ของ Layer ท่ีกําลังเลือกทํางานในสวน Grdient Overlay 
C :   กําหนดรอยละความโปรงแสงทึบแสงของ Gradient Overlay 
D :   การกําหนดลักษณะการไลสี โดยคลิกท่ีดานทายเพ่ือเปด Gradient Perset และคลิกเลือก หรือ

คลิกท่ีตัวอยาง Gradient เพ่ือกําหนด Gradient ดวยตัวเอง 
E :   ตัวเลือกเพ่ือกลับทิศทางการไลสี 

  
F :   เลือกรูปแบบการไลสี 

     
            Linear                        Radial                         Angle                      Reflacted                     Dimond 

G :   กําหนดมุมของการไลสีโดยการคลิกลากมุมในแผนภาพ หรือกําหนดตัวเลขมุม 

   
          Angle = 0                    Angle = 45                 Angle = 90 

H :   กําหนดรอยละชวงท่ีมีการผสมสี โดย 0 % จะไมมีการผสมส ี100 % จะมีการผสมสีเต็มชวง 

A 

B

C
ED

G
F

F
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Pattern Overlay 

Pattern Overlay ใชสําหรับนําเอาลวดลายท่ีเราเลือกไปแทนที่หรือผสมสีภาพใน Layer การกําหนดคา 
Pattern Overlay มีรายละเอียดดังนี้  

 
 

A :   หัวขอ Pattern Overlay 
B :   ตัวเลือกโหมดผสมสี ของ Layer ท่ีกําลังเลือกทํางานในสวน Pattern Overlay 

    
           Normal                       Darken                    Color Burn                  Difference 

C :   กําหนดรอยละความโปรงแสงทึบแสงของ Gradient Overlay 

    
        Opacity = 10              Opacity = 30               Opacity = 60               Opacity = 100 

D :   การกําหนดลักษณะลวดลาย โดยคลิกท่ีดานทายเพ่ือเปด Pattern Perset และคลิกเลือก หรือ
คลิกท่ีตัวอยาง Pattern 

    
E :   กําหนดรอยละอัตราสวนของ Pattern 

    
       Scal = 100%                Scal = 200%               Scal = 500%              Scal = 1000% 

A 

B

C

E

D
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Stroke 

Storke ใชสําหรบัสรางเสนขอบภาพใน Layer ท่ีเลือกทํางาน การกําหนดคา Storke มีรายละเอียดดังนี้  

 
 

A :   หัวขอ Storke 
B :   กําหนดขนาดของ  Storke เปน Pixel 

    
                    Size = 1                     Size = 5                     Size = 10                  Size = 15 

C :   ตัวเลือกตําแหนงเทียบกับแนวขอบภาพ 3 ตําแหนง Outside, Inside, Center 

    
                     Outside                       Inside                        Center 

D :   ตัวเลือกโหมดผสมสี ของ Layer ท่ีกําลังเลือกทํางานในสวนท่ีเปน Storke 

    
                     Normal                       Darken                       Lighten                   Luminosity 

E :   รอยละความโปรงแสงทึบแสงของ Storke 
F :   รูปแบบการเติมสี Storke เปน 3 แบบคือ Color(สีพ้ืน) Gradient(ไลสี) Pattern(ลวดลาย) 
G :   กําหนดสีของ Storke 

A 

B

C

E
D

F
G
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   Edit Style Effect 
  แ ก ไ ข ส ไ ต ล เ อ ฟ เ ฟ ก ต  

 

 
 
 
 
 
 
 
 
 
 

 

Show/Hide Style Effect 
 

Style Effect ตางๆ ท่ีสรางขึ้นมาสามารถที่จะซอนและแสดง ไดโดยคลิกท่ีไอคอนรูปตาหนา Style 
Effect นั้นๆ ถามีรูปตาแสดงวา Style Effect นั้นแสดงอยู 
 

                
 

               

การสราง Style Effect ใหกับ Layer สามารถสราง Style 
ได หลายๆ ชนิดใน Layer เดียว โดย Style Effect ท้ังหมดจะ
ถูกแสดงอยูดานลางของ Layer นั้นในหนาตาง Layer Palette 

การซอน-แสดง Style Effect ของ Layer ทําไดโดยคลิก
เครื่องหมายดานหลัง Layer และถาตองการแกไข Style Effect 
ใดก็ดับเบิลคลิกท่ี Style Effect นั้น 

คลิกแสดง-ซอน 
Style Effect 

ปด Color Overlay
แสดง Gradient Cverlay 

ปด Style Effect ทั้งหมด 

ปด Color Overlay 
ปด Gradient Cverlay 
แสดง Pattern Overlay 

ปด Color Overlay
ปด Gradient Cverlay 
ปด Pattern Overlay 
แสดง Storke
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Disable/Enable Style Effect 
 

 
 
 

Global Light 
 

 
 

หากตองการระงับผลของ Style Effect ใดใน  Layer 
สามารถทําไดโดยคลิกขวาท่ี Layer Style Effect นั้นๆ และ
เลือก Disable Style Effect และถาตองการใหมีผลของ 
Style Effect ใดใน  Layer สามารถทําไดโดยคลิกขวาท่ี 
Layer Style Effect นั้นๆ และเลือก Enable Style Effect ใน
ตําแหนงเดียวกันอีกครั้ง 

หากตองการระงับผลของ Style Effect ใดใน  Layer 
สามารถทําไดโดยคลิกขวาท่ี Layer Style Effect นั้นๆ และ
เลือก Disable Style Effect และถาตองการใหมีผลของ 
Style Effect ใดใน  Layer สามารถทําไดโดยคลิกขวาท่ี 
Layer Style Effect นั้นๆ และเลือก Enable Style Effect ใน
ตําแหนงเดียวกันอีกครั้ง 

คลิกลากเพ่ือปรับตําแหนงคา Angle 
(มุม) และ Altitude (ระยะหางระหวางเสน
รอบวงและจุดศูนยกลาง) 
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Create Layers 
 

Layer Style Effect สามารถเปล่ียนเปน Layer ไดโดยคลิกขวาท่ี Layer Style Effect ในหนาตาง 
Layers Palette จากนั้นจึงคลิกเลือกท่ี Create Layers โดยผลที่เกิดขึ้นกับ Layer หลักจะยังคงเหมือนเดิม
เพียงแตเปล่ียนสถานะภาพของ Style Effect ตางๆ เปน Layer เทานั้น 

 

   
 

Scale Effects 
 

Scale คือการกําหนดขนาดของ Style Effects ใน Layer สามารถปรับแตงไดโดยคลิกท่ี Style Effects 
ของ Layer ในหนาตาง Layers Palette จากนั้นจึงคลิกเลือกท่ี Scale Effects เพ่ือเปดหนาตาง Scale Style 
Effects เพ่ือปรับคารอยละของขนาด Style Effects 
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Copy/Paste Effects 
 
 

 
 

Clear Layer Style 
 
 

 

Layer Style ท่ีสรางขึ้นมาเปนอยางดีแลว สามารถ
สําเนาไปใชกับ Layer อื่นๆไดโดยคลิกขวาท่ี Stlye 
Effect ท่ีตองการสําเนาในหนาตาง Layers Palettes 
จากนั้นเลือก Copy Layer Style การนําเอา Layer Style 
ไปใชกับ Layer ใดทําไดโดยคลิกขวาท่ี Layer อื่นท่ี
ตองการใช Layer Style แบบเดียวกัน และเลือก Paste 
Layer Style  

เมื่อตองการ Clear Layer Style ท่ีสรางขึ้นมาออกจาก 
Layer Palette สามารถทําไดโดยคลิกขวาท่ี Stlye Effect ท่ี
ตองการลางออก ในหนาตาง Layers Palettes เลือกท่ี 
Clear Layer Style 

หรืออาจเลือกลาง Layer Style 
เพียงบางตัวออก สามารถทําได
โดยคลิกท่ี Layer Style แลวลากลง
ท่ีไอคอนรูปถังขยะ ดานลางของ 
Layer Palette 
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   Styles Palette 
  ห น า ต า ง ส ไ ต ล  

 

 
 
 
 

การสราง Style Effect ใหกับ Layer ยังสามารถสราง Style Effect ไดจาก Style 
สําเร็จรูปมาใชงานกับ Layer ท่ีกําลังเลือกทํางานไดโดยคลิกเลือกจาก Style Palette ท่ี
เปดขึ้นมาใชงานจาก Menu Windows > Styles 

เลือก Style ที่ตองการจาก 
Style Palette 

เกิด Style Effect Layer 
จากการ เลือก Style จาก 
Style Palette 
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